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These notes are designed for you to work through at your own pace. They do not explain 

every feature of the program therefore you are expected to make use of the Help facility. 

 Note:  This icon denotes important information – read it carefully. 

 Tasks  This icon denotes a task which should be carried out to help you gain the skills 

required. 

If you have any comments or queries, please contact: 
The ICT Skills tutor within your Learning Development Centre. 
Glasgow School for Business and Society – 0141 331 3300 
School of Health and Life Sciences – 0141 331 3456 
School of Engineering and Built Environment – 0141 273 1230 
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Creating a Poster - Guidelines 

Before creating a poster, you should plan it by deciding what important information you 
want to include and how you want to present it. 

Here are some tips for creating a poster:  

1. Focus on the purpose of the poster, is it: 

 To provide information 

 A summary of work or research 

 To provoke thought 

2. Consider the audience. 

3. Choose an appropriate font type and size. 

 Do not include large sections of text – remember it is a poster, not an essay. 

 Avoid confusing terminology and acronyms. 

4. Use diagrams and images where possible, posters are visual. 

5. Choose suitable complementary colours, do not have too many. 

Here are some common research poster elements: 

 Title and Authors (with any institutional affiliations) 

 Purpose (Introduction/Objective) 

 Methods 

 Results/Findings 

 Discussion 

 Conclusions/Summary 

 Acknowledgements and References 

As a student, or in work, you may be asked to create a poster on a certain subject. You 
can use a computer to help you do this. One program used for this is Microsoft Publisher. 

This is part of the Microsoft Office suite of programs. The following notes will describe 
how to work with Publisher and will introduce some of the most useful features of the 
program. 

When/if things go wrong 

Remember that when/if an error occurs try the following to rectify the situation. Click on 

the Undo   command from the Edit menu. 

Help 

If there is a feature of Publisher you would like to use but do not know how, use the Help 
facility within the software. This provides instructions on using all features of the 

software. To use Help simply click on the Help icon . This will open the Help dialogue 
box. Then you can choose to browse Publisher 2016 support or type a phrase to search by 
in the Search help box.  
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Starting Publisher and opening a Blank Poster 

The following notes will guide you through the creation, editing and saving of a poster. 
Work should be saved regularly as the poster is created. To open Publisher, click on the 
Start menu, All Programs, Microsoft Office and then click on Microsoft Publisher 2016. 
This will open and display the Available Templates window with options which can be 
used to start a new poster, Figure 1. 

 

Figure 1: The Microsoft Publisher Available Templates 

Click the More Blank Page Sizes command, Figure 1. The Blank Page Sizes window opens 

displaying different blank templates, . 

 

Figure 2: The More Blank Page Sizes window 
  

More Blank Pages Sizes 

Information 
Pane 
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When one of the poster sizes is selected the pane on the right side of the screen will 
display information on the size you have chosen, and will provide additional options for 
you to customize the poster. A font and colour scheme can be chosen from these menus. 

Make the selections and click on the Create button. The blank poster will open in 
Publisher.  

 

Saving a Poster 

To save a poster, click on the File menu and choose Save. When saving a poster for the 
first time, a poster name and location (i.e. the folder and drive) must be given. Further 
saves will use the same poster name and overwrite the previously saved version. The 
Save As... command allows the poster to be saved with a new or different name leaving 
the original unchanged. This is useful for keeping different versions of a poster or creating 
back-up copies. 

 Note: It is important to get into the habit of saving the file frequently.  

 

Resizing a Poster 

Once the poster is created it can be resized or the orientation can be changed. To do this, 
from the Page Design tab you can select a different page size or orientation, Figure 3. 
Other templates can also be applied from this pane. 

 

Figure 3: The Page Design tab 

 Note: If the page size required is not displayed, (see Appendix 1 for size 
information), click on the Create new page size… option under the Custom section. The 
Create New Page Size dialogue box will open enabling you to set the width and the height 

 Task 1 

Open Microsoft Publisher and choose the A3 (Portrait) option.  

 Task 2 

Customise the poster by choosing the Marine colour scheme and the Office 3 font 
scheme. Click on the create button to create the poster. 

 Task 3 

Save the poster in your user workspace (C: drive or pen drive) with the name LDC 
Poster. 
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of the new page size. Give it an appropriate name and click on the OK button to create 
the new page size and close the dialogue box. 

 

 

Figure 4: Microsoft Publisher document 

Entering Information on a Poster  

When entering information on a poster remember that most people tend to read English 
in a specific way, that is, from left to right and top to bottom. This should be taken into 
consideration when creating a poster ensuring that the information is displayed in a 
logical manner. Adopting a columnar design can help ensure that readers view the poster 
in the correct sequence and using cues can also help. These cues could be in the form of 
adding numbering to headings or arrows could be used to point the way. A good poster 
will be laid out in a way that the reader will instinctively read it in the correct sequence. 

 Task 4 

Change the poster to A1 size, landscape format. Save the poster. 
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Figure 5: Flow of Information on a Poster 

Entering Text on a Poster 

To enter text on a poster, a text box must be created that will contain the text. To do this, 

click on the Draw Text Box command from the Home tab, Objects group. The cursor 

will change from an arrow to a +, click and drag in the poster area until the text box is the 

size required. It is then ready to type the text inside. This text can be formatted using the 
tools from the Home tab in the same way as in Microsoft Word. For example, the font 
size, colour or alignment can be changed.  

 

Resizing the text box 

If the text box is not big enough to hold all of the text inside, the  resizing handles at the 
corners and the middle of the sides of the text box will turn red and an ellipsis (triple dot) 
is shown on the bottom side of the text box, Figure 6.  

 

Figure 6: Text box which is too small for content 

 

Introduction 

Conclusion 

Title 

Author 

Introduction 

Conclusion 

Title 

Author 

 Task 5 

Add a title at the top of the poster. This title should say “Glasgow School for Business 
and Society Learning Development Centre. Make the text Calibri font, size 72 and 
Bold.  
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To fit the text into this text box, either enlarge the text box or reduce the font size of the 
text. To resize the text box, click on it, the resizing handles will appear. Position the 
mouse cursor over one of the resizing handles and the mouse cursor changes to a double-
headed arrow. When the double headed arrow is displayed, click, hold down the left 
mouse button, and drag the mouse away from the text box to increase the size or drag 
toward the centre of the box to decrease the size. Release the left mouse button when 
finished. 

Overflow text 

Alternately Publisher offers an option to overflow text that does not fit within a text box 
into another one. The text is hidden until it can flow into a new text box. To use this 
function, create a second empty text box where the extra (overflow) text will be entered. 
Then click on the ellipsis (triple dot) symbol on the first text box, the cursor will change to 
a pouring jug. Then click in the second text box and the overflow text will be displayed 
there. The two text boxes remain linked and the text will simply flow from the first to the 
second box with any changes made to it. 

 

 

Copying Text from another Source 

If copying text from another source, for example the web, go the webpage and copy it. Go 
to your poster and create a text box to contain the information. Click inside the text box 
and paste the text by clicking on the Paste command form the Clipboard group in the 
Home tab. By default, it will paste the text and keep the original formatting of the text. If 
you want to specify a different paste option you can click on the downward arrow below 

the Paste icon and choose the relevant option from the list that will be displayed, i.e.  

for simple paste or  to paste just the text and use the formatting of the surrounding 
text. 

Moving text 

To move a text box, place the mouse cursor somewhere on the outline of it. The cursor 
will change to a four-headed arrow. Hold down the left mouse button and drag to move 
the text box to the new area. The dotted outline of the text box will follow your mouse 

 Task 6 

Choose to resize the text box or to overflow into another text box to ensure all words 
are visible. 

 Note: Remember if you choose the overflow option these two text boxes are linked, 
changes in the content of one will impact on the other, regardless of where it is placed. 

 Task 7 

Insert another text box with your name and Glasgow Caledonian University as your 
institution. Choose an appropriate font type and size. 
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movement indicating the text box’s new location. Release the left mouse button when 
the text box is where it should be.  

 Note: The same method is used to move other elements including images and 
shapes. 

 

Adding Images  

To add images to a poster, pictures, WordArt, shapes or personal image files can be used. 
Using one or more of these will make the poster visually appealing to the target audience 
and to enhance the information. 

 Note: The 2016 version of MS Office no longer includes ClipArt. To insert pictures, 
use the Picture or Online Picture command. The Online Picture command takes you to 
Bing to search for pictures by topic. These images have Creative Commons licences which 
should be attributed if required. 

Image types 

There are two main types of images on a computer. These are bitmaps (pictures) and 
vectors (drawings). While bitmaps store the image as a sequence of individually coloured 
pixels, vectors are stored as a series of instructions the computer processes in a fraction 
of a second to draw the image. What you can do with the image can be limited by the 
type of image chosen. If you stretch a vector drawing then it will look okay, but as a 
bitmap is stretched it will start to look blocky as the pixels are scaled in size. If you find 
that images you include in your poster look bad as you increase their size, you may 
benefit from trying to find a similar image that is a vector or try to find a better quality 
(better resolution, more pixels) picture. The drawback here is that vectors can only 
display relatively simple diagrams and pictures, not photographs. To find out how to 
distinguish between the two types as well as what type of files contain what sort of image 
see Appendix 2. 

Picture 

You can insert your own picture or a picture that you have taken from other sources 
(remember that you may need to reference this or ask for permission from the author to 
use the image). To insert an image from a file, go to the Insert tab, Illustrations group and 
click on the Picture icon. The Insert Picture dialogue box will open. Navigate to the folder 
you have saved the picture in. Double click on it (or click once and then click the Insert 
button) to insert the image in your poster. 

 Task 8 

Go to the Glasgow School for Business and Society Learning Development Centre 
website http://www.gcu.ac.uk/gsbs/ldc/ and copy the first paragraph. 

Create another text box and paste the copied text inside. Make the text Calibri font, 
size 36. Resize the text box if necessary and move it to the left hand side of the 
poster. 

http://www.gcu.ac.uk/gsbs/ldc/
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Resizing an Image 

To resize a picture, click on it and the resizing handles will be displayed in the corners and 
the middle of the sides. It can then be resized in the same way as a text box. It is 
important to remember to keep the original proportions of the image (unless it is 
intended to be distorted). To keep the image proportions always use the corner resizing 
handles and keep the Shift key on the keyboard pressed when dragging to the desired 
size. 

Adjusting an Image 

The Picture Tools - Format tab, Figure 7 should be displayed when you click on an image 
in your poster.  

 

Figure 7: Picture Tools - Format tab 

There are a number of useful tools available on the Picture Tools - Format tab.  Picture 
corrections can be made within the Adjust group making pictures lighter or darker as 
required. Objects can also be aligned and grouped as preferred using the commands 
within the Arrange group. Images can also be cropped.  

Cropping an Image 

If there is an image that could be used, but only a portion of it is to be displayed it can be 
cropped to the size required. To crop an image, click on the Picture Tools - Format tab 
and from the Crop group click on the Crop icon. The image will now have cropping 
handles on the corners and the sides that will look like this  or . Position the mouse 
cursor over the corner or side handles and it will change to the same as the handle. Then 
click and drag using the left mouse button to crop the image.  

 Note: Cropping an image will not delete the part of the image that has been 
cropped. It will just hide it. If it has to be permanently deleted, click on it and click on the 
Compress Pictures icon from the Adjust group in the Picture Tools - Format tab. A 
dialogue box will open with different options. Choose the best quality available for the 
image (for commercial print for example) and always choose the option to apply these 
compression settings only on the selected picture. Click on the Compress button to apply 
the settings to the image and cut its cropped area. 

 Task 9 

Insert a logo into your poster at the top left hand corner, this could be the University 
logo or the logo of an organisation involved in the research.  

 Note: If you do not have one, search the internet for something appropriate. 

Save the file. 
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WordArt 

WordArt is used to make text more visually appealing. The text entered with WordArt 
can be uniquely styled and coloured. WordArt is most commonly used for titles, headings 
or a few words you would like to draw attention to.  

 Note: Do not overuse WordArt. It can add interest to your text but if you use it too 
much it can be off-putting for the viewer. 

To insert WordArt, first click on the WordArt  command on the Insert tab, Text group. 
The WordArt gallery will open, Figure 8. Choose a style and click on it. The Edit WordArt 
Text dialogue box will open. Replace the words “Your Text Here” with the words to be 
entered using WordArt. At this point, changes to the font style and size can be made by 
using the drop-down menus at the top of the dialogue box. Click on the OK button to 
insert the WordArt. 

 

Figure 8: WordArt gallery 

 Note: WordArt can be moved and resized using the same method as for resizing 
and moving images. 

To modify the design of the WordArt click on it and the WordArt Tools – Format tab will 
be displayed, Figure 9. The WordArt text editing options will be displayed allowing the 
direction of text or its fill and outline colour to be changed.  

 

Figure 9: WordArt Tools – Format tab 

 Task 10 

Insert an appropriate image in the poster. Resize and crop the image if required. 
Make the image brighter. Save the file. 
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Shapes 

AutoShapes allow simple geometric shapes like circles, squares and stars to be added to 
the poster. These can be used to form drawings, diagrams or design elements for the 
poster. To insert a shape such as a star or a diamond, click on the Shapes command 
within the Insert tab, Illustrations group. A gallery of shapes will be displayed. Click the 
shape to be added such as Oval. Click and hold down the mouse button on the poster 
where the shape is to be displayed and then drag until it is the required shape and size. 

The format of Shapes can be changed, for example the fill colour, outline colour and style. 
Effects like shadow or 3D can also be added from the tools available in the Drawing Tools 
– Format tab, Figure 10.  

 

Figure 10: Drawing Tools – Format tab 

 

Additional Design Objects 

Publisher also provides different design objects which allow a more professional look to 
be applied to the poster. Each design object is made up of a number of elements and is 
customisable so it can be modified to suit the needs and ideas which are to be expressed 
in the poster.  

To insert a design object, click on the Insert tab and choose the design object from the 
Building Blocks group. There are Page Parts, Calendars, Borders & Accents and 
Advertisements types available. Each one of these options will open a gallery for a 
specific design object to be chosen as required. From the Page Parts gallery there are  
Headings, Pull Quotes, Sidebars or Stories which can be inserted, Figure 11. Browse 
through the options and click on the one to be used. It will be inserted in the poster and 
placed in the middle. It can be moved and resized it in the same way as a text box or an 
image. 

 Task 11 

Add some WordArt to the poster as headings for the main sections: Introduction, 
Methodology, and Results. Choose any style. Move the WordArt to the appropriate 
position in the poster. 

Resize the WordArt appropriately. Change the text fill in colour to blue and the 
outline to black. 

 Task 12 

Using the Shapes function, place a star at either end of your name and University text 
box. Change their fill colour to light blue and the outline to a darker blue. Save the 
poster. 
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The colours of inserted objects will be based on the colour scheme you chose when you 
created the poster. 

  

Figure 11: The Page Parts gallery 

 

Grouping 

Grouping objects together enables multiple objects to be manipulated, moved, resized 
and aligned as one whole object. To group items, first hold down the Shift  key and click 
on each of the items to be grouped. Once they have been selected, click on the Drawing 
Tools – Format tab or the Picture Tools – Format tab (depending on the objects you have 

selected), and from the Arrange group click on the Group  command. Once 
grouped clicking on any one of them will select all of them and moving or resizing changes 
will be applied to all elements in the group.  

Many design objects are made up of several elements which have been grouped together 
for ease of use and manipulation. To select and edit each element of a design object they 
will need to be ungrouped. To ungroup items and manipulate them individually, select 
the design object, and click on the Drawing Tools – Format tab or the Picture Tools – 
Format tab (depending on the objects you have selected),  and from the Arrange group 

click on the Ungroup  command. The object will then be ungrouped and 
individual elements selected. 

Customising design objects 

To make changes to individual design object elements select the part to be changed. To 
do this, simply click on it and the resizing handles on that particular element will be 

 Task 13 

Insert one of the Page Parts objects in the poster.  Resize if necessary. 
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displayed as well as the handles of the design object itself. Once selected the relevant 
context tab will appear, i.e. if a drawing object has been selected the Drawing Tools – 
Format tab will be displayed and if a picture object has been selected, the Picture Tools – 
Format tab will be displayed. 

To edit text, select the current text in the object and then replace it by typing in your 
desired text. Elements of the object can also be deleted, or moved around. 

 

Tables 

Tables can be invaluable in representing data and figures in a readable form. Using a table 
in Publisher is very much like inserting one in Microsoft Word or PowerPoint. There are 
two main methods that can be used to create a table: 

 Table Gallery: On the Insert tab within the Tables group select Table . The 
Insert Table menu will be displayed. Drag across the cells to select the number of 
rows and columns you want in your table. Notice that when you drag across the 
cells a preview of the table will be displayed on the document itself. When you 
have the correct number of rows and columns simply click and the table will be 
inserted in your document. This will create a table using Word’s default table 
formatting. 

 Insert Table: On the Insert tab within the Tables group select Table , and then 
Insert Table from the menu. This will launch the Insert Table dialogue box. Select 
the number of columns and rows required and click OK. 

Text can be added to the table by clicking inside a cell and typing. To move from cell to 
cell click on the Tab key or use the arrow keys on the keyboard. Tables can be moved and 
resized like all other elements entered on a poster.  

By default, the table will not have any visible borders. To display the borders click on the 
table and then go to the Table Tools – Design tab, Figure 12. From the gallery in the Table 
Formats group, one of the preset styles can be applied to the table. Or the tools in the 
Borders group can be used to specify each border of the table.  

  

 Task 14 

Customise the design object by deleting elements, editing the text, inserting images, 
changing the colour of the fill or outline.  

Go online to the LDC webpage and copy some text and paste it into the sidebar you 
have entered. 

Leave space below the picture. 

 Note: you will need to ungroup the objects to either delete or move individual 
elements. 
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Figure 12: Table Tools - Design tab 

 

Arranging Items in Publisher 

Once there are a large number of elements in a poster it can be tricky organising them 
and keeping them tidy. Publisher helps with a number of options to help arrange objects.  

Grid lines 

Grid lines can be displayed on a poster to make it easy to line up and lay out all of the 
elements on screen. These gridlines will not be printed – they just help to arrange the 
objects on the poster. To display gridlines, click on the Page Design tab and click the 
Guides option from the Layout group. The Guides gallery will open, Figure 13. Predefined 
guide options will be displayed, choose one, or use the options at the bottom of the 
gallery to specify one not listed.  

 

Figure 13: The Guides gallery 

 Task 15 

Insert a table into the poster. It should have 2 columns and 4 rows. Type in the first 
cell Contact, and in the next cell Details. 

Type in the first column under Contact the following information: Office, Phone, 
Email. 

Type in the second column under Details the following W508 & W509, 0141 331 
3300, ldcgsbs@gcu.ac.uk 

Resize your table to fit the data. Make sure to resize and move the elements in your 
poster so that everything fits well and looks tidy.  

mailto:ldcgsbs@gcu.ac.uk
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A vertical or horizontal guide line can also be placed within the poster. To create a vertical 
guide, click on the vertical ruler on the left hand size of the poster and drag inside the 
poster area. A thin green guide line will show. Simply release the mouse button when you 
have dragged the guide line to the position required. To create a horizontal guide line, 
click on the horizontal ruler and drag inside the poster area in the same way. 

Guide lines can be moved by simply clicking on it and dragging it to a new position. To 
remove a guide line just click on it and drag it back to the ruler. 

 Note: The guide line will not be printed even if they are displayed on the screen. 

 

Aligning 

Aligning objects on the poster will make it look more structured and tidy. By default, 
when an object is moved a pink line will be displayed between different objects to enable 
alignment with other objects in the poster. This allows for greater control while moving 
objects to align them.  

Multiple objects can be aligned at the same time. To align objects (text boxes, images, 
and so on) on the poster first they must be selected. To select more than one object click 
on the first object and then press and hold down the Shift  key on the keyboard and 
click on the next object. Once all of the objects you want to align have been selected, click 
and drag them to the selected area.  

Objects can also be aligned by selecting the object to be aligned and then from the 
Drawing Tools – Format tab or the Picture Tools – Format tab (depending on the objects 
selected), Arrange group click on the Align option. A drop-down menu will be displayed 
with aligning options. Click on the aligning option required. 

 

Order 

When adding elements to a poster, they are placed on the poster in the order in which 
they were created. To rearrange the order, select the item that to be moved and then 
from the Drawing Tools – Format tab or the Picture Tools – Format tab (depending on 
the object you have selected), the Arrange group click on the Bring Forward 

 or Send Backward  options to move this object one step 
forward or one step backward. To access more options, click on the downward arrows at 
the end. This will be useful if there are multiple items layered on top of each other.  

 Task 16 

Use a horizontal guide line to make sure that objects within the poster are aligned. 

 Task 17 

Try out some of the alignment options on elements of the poster. 
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Text Wrapping 

Text wrapping refers to the way the text flows around other objects. By default, if the text 
is behind another object the text wrapping of that object is through. The text in this case 
will make space for the object so the object will not cover the text. The space made for 
the object will be of the same shape, i.e. if the object is an oval the text will wrap around 
an oval space to allow both the text and the object to be visible.  

To modify how the text wraps around a specific object, click on the object and then from 
the Drawing Tools – Format tab or the Picture Tools – Format tab (depending on the 

objects you have selected), the Arrange group click on the Wrap Text  option and from 
the drop-down menu, Figure 14 choose the wrapping option you want.  

 

Figure 14: Wrap Text drop-down menu options 

 

 Task 18 

Try out some of the ordering options on elements of the poster. 

 Task 19 

Group the items in the page parts design object you inserted.  Move it to ensure it all 
moves together.  

 Task 20 

Try out some of the text wrapping options on one of the stars and some of the text to 
see the effect this has. 

Save your poster. 
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Printing a Poster 

Printing a poster in Publisher is very much like printing in Microsoft Word or Excel. To 
print, click on the File tab. From the list of option on the left select the Print option. The 
print options and the print preview of your poster will appear as in Figure 15. Make sure 
the appropriate printer is chosen (a printer that can print on paper the size of your 
poster). Once chosen, the most important options here are the correct paper size and the 
One page per sheet (instead of the default Tiled option). When all options are selected, 
click the Print button to print the poster.  

 

Figure 15: Print options and preview 
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Additional Tools 

Poster templates 

Sometimes, when creating a poster, you may want to use a template to save you time in 
designing and laying out all of the elements. To do that, from the Page Design tab, in the 

Template group, click on Change Template  icon and the Change Template window 
will open, Figure 16. From here you will have a number of categories of possible 
templates. Choose one of these templates by clicking on it to apply it to the poster you 
are working on.  

 Note: You can get the same results for your poster without using a template; it just 
takes a little more time. In this booklet we do not use templates so that you learn more 
about laying out your own design for a poster.  

 

Figure 16: Change Template window 

Appendix 1: Paper Sizes 

Standard Paper sizes (ISO standard): 

Paper Size 
Portrait  Landscape  times A4 sheets 

A0 84 x 118.9 118.9 x 84 16 

A1 59.4 x 84 84 x 59.4 8 
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A2 42 x 59.4 59.4 x 42 4 

A3 29.7 x 42 42 x 29.7 2 

A4 21 x 29.7 29.7 x 21 1 

A5 14.8 x 21 21 x 14.8 
1

2
 

A6 10.5 x 14.8 14.8 x 10.5 
1

4
 

 

All measurements are given in centimetres, horizontal measurement first and then 
vertical measurement  
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Appendix 2: Image File Formats 

Bitmap (raster) formats 

These files use pixels to compose an image and therefore are suitable for high quality 
photographs. The files are usually with bigger size and when resized may lose quality. 
Images are always rectangular. They are always dimensioned with a width and height (in 
pixels). Images that appear to be with a different shape are not, they simply have a 
transparent background. 

JPEG 

Joint Photographic Experts Group (JPEG) files uses 24-bit colour which means it is not 
losing the colour quality. However it uses compression with variable degree of quality 
loss. Most users won't be able to see much difference between a moderately compressed 
JPEG and the original uncompressed image; a heavily compressed JPEG will appear blurry 
and make individual pixels noticeable. The resulting files are small and depending on the 
degree of loss during compression may be useful for good quality photographs. The only 
major drawback of using JPEG is that it doesn’t support transparency. 

BMP 

This is a standard Microsoft image format and images created with Paint software 
(standard software installed with Windows) use this file format. Typically, BMPs do not 
use compression and that is why they are very large files. BMP files do not support 
transparency.  

GIF 

Graphics Interchange Format (GIF) files are commonly used on Web pages. They only 
support up to 8 bits of colour depth (or 256 colours) but it creates a table of up to 256 
colours from a pool of 16 million and that way it doesn’t noticeably degrade the original 
image. If the original image consists of fewer than 256 colours GIF format will create save 
and compress the image without any loss of quality. However if the image is a colour rich 
it will lose a greatly the quality. GIF files support transparency. 

PNG 

Portable Network Graphics (PNG) was originally developed to replace the GIF format. 
They use compression without loss of quality and can use 24-bit colours (more than 16 
million colours) to achieve a much wider range of colours compared to GIF files. PNG also 
supports transparency and therefore is suitable for images that are not rectangular and 
will be placed on different backgrounds. 

TIFF 

Tagged Image File Format (TIFF) files can be saved completely uncompressed for 
maximum quality. They can also use a compression without loss of quality to help 
decrease file size. Like PNGs and GIFs, the TIFF format supports full 24-bit colour (more 
than 16 million colours). TIFF files are suitable for high quality photographs and they 
support transparency. 
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Vector formats 

These files contain instructions on how to build images using geometry rather than pixels. 
They can be resized without worrying that the quality will degrade 

EPS 

Encapsulated Post Script (EPS) is a vector format files and are widely used in professional 
printing for printing vector-based graphics. They are suitable for graphics such as logos or 
other that don't contain many photographs. 

WMF 

Windows Metafile Format (WMF) was created by Microsoft. Most of the Microsoft Office 
Clip Art is in WMF format.  

 

 

 

 

 

 
 

 
 

 

 

 
 


